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01.Features of prezvision

1.3D Space

prezvision 3D space is expressed with X(Left - Right), 

Y(Top - Bottom), and Z(Front - Back) coordinate axis.

Base Board
A virtual whiteboard is set up on the prezvision Canvas. 

This board is called "BaseBoard". The object's (Shape, 

Connector, and Grouping objects)position and angle on 

the Canvas are expressed based on this BaseBoard.(Fig-1)

prezvision has original characteristics such as "3D space", "Objects ID" and "Slide ID".

However, you can operate it without considering these concepts.

Fig-1 Canvas and BaseBoard

Y-axis

Z-axis
X-axis

Canvas

BaseBoard

2.ID

In prezvision, "ID" is given to each slide and each object, and the "ID" bears a key role. ID plays a different role for the slide 

and the object. In addition, you can edit "ID" in "Shape ID area". Seamless Transition can be configured by setting the ID. 

Object ID
ID is automatically allocated in the object on the Canvas, 

which is prefixed by a Tilde (~)symbol. (Fig-2)

When a text is inserted in the Shape, this text is allocated 

as ID. Up to 24 characters of the first line will be considered 

for this(regardless  of whether  one- byte or two-byte)

In this case, space and the tab included in the text are 

converted into underscore (_) respectively.

Fig-2 Automatic Allocation of ID
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ID and Seamless Transition
The object with same ID becomes the target of "Seamless 

Transition" between two slides. As a result, smooth animation 

is achieved at the slide show.(Fig-3)

It doesn't limit to 1-1 objects, and this is the same thing even 

if this is 1-two or more cases. 

This is not limited to 1-1 objects, it also applies to 1-2 or more 

cases.

When   the Object Grouping  contains object with different 

size, angle, and position, etc. , the transition is not normally 

done.

Slide ID
prezvision slide has identification ID for the link. A unique 

ID is automatically allocated when a slide is created or 

duplicated. In (ID automatically) automatic allocated ID, 

and is prefixed by a Tilde  (~).(Fig-4)

Moreover, ID is checked unique, and cannot input unique ID that not is though is revokable.

When the link is contained in the slide to which ID is changed, it is automatically reflected in the target Shape. 

Check on Unique when Insert Slide Set
When inserting a Slide Set, prezvision automatically check for unique ID, and allocate a unique ID for each slide. 

Fig-3 Seamless Transition

Fig-4 Slide ID
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02.Interface

1.Interface Layout

When prezvision is started, the Main Window is displayed. This chapter explains the name and the function of the 

Operation Interface.

Menu Undo/Redo Edit Text Operate Viewpoint

Shapeshift ON/OFF

Setting Shape area

Canvas

Managing Slide area Edit Property area Shape ID area

Color Preview

Setting Color area
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2.Interface Function

Menu

[File] menu

New

Create  a new Slide Set.

Open

Open  an existing silde set.

Save

Save  the changes made in the current Slide Set.

Save  As

Save the data to a different file format, location or 

filename.

Import  Data

Import  a Microsoft PowerPoint Slide to prezvision.

Export  Data

Convert the Slide Set to a different format.

Slide-Set  Setting

Setting a Slide set aspect ratio, horizontal angle of view 

and Baseboard size etc.

Print as PDF

Export the Slide Set in Adobe PDF format.

Exit

Quit the application.

[Edit] menu

Undo / Redo

* Only applicable for Shapes and Viewpoint.

Cut

Cut Shapes or slides out to the clipboard.

Copy

Copy Shapes or slides out to clipboard.

Paste

Paste Shapes or slides from the clipboard.

Paste Properties

paste the copied properties to selected Shapes.

Delete

Delete the selected items.

Select All

Select all Shapes on a Canvas.

Deselect All

clear the selection

Find

Search for a text in multiple Slides.

Replace

Replace a text in multiple Slides.

Grouping

Group/Ungroup selected Shapes.

View point

Manipulate the viewpoint.

Lighting

Manipulate the lighting position.

Reset Angle

Reset the selected Shape's angle.

Divide By Lines

Divide a multiline text Shape into multiple Shapes.

Create LinkSlide

Create the cross-linked slides from the selected Shapes.

[View] menu

Normal

Returns to the slide edit mode.

Slide List

Browse all Slides.

Slideshow

Start a Slideshow from the selected slide.

Master

Edit the title master, or the slide master.

Grid and Guide

Setup grid, and guide.

[Insert] menu

New Slide

Create a new slide after the Selected slide.

Duplicate Slide

Duplicate the selected slide and insert just after the 

original.

Slide Set

Insert a Slide Set.

Picture

Images, or Videos on the Canvas.

Graph

Insert a graph from prezGraph.

Capture Device

An object that shows real time image (from the Capture 

Device) will be inserted on the Canvas.

3D Model

Insert a 3D model on the Canvas.
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[Tool] menu

Option

Set options.

Open the option dialog.

[Slideshow] menu

Run

start the Slideshow.

Auto Run

start the auto play Slideshow.

[Help] menu

Tutorial

View the Tutorial.(PDF format)

User's Guide

View the user's guide.(PDF format)

Official Site

Open the prezvision official site.

User Registration

Open the user registration page.

Contact SoftAdvance

Make inquiries about prezvision.

Version

Display the version information.

Canvas
You can type a text, or layout Shapes on the Canvas to 

create a slide.

Managing Slide Area
You can manage the edited slide on the Canvas.

You can check the transition, without run slide show.

Setting Shape Area
Select Shape or connector from each category, and  

arranges it on the Canvas with the click or the mouse drag.

You can change selected Shape style on the Canvas.

This is called "Shapeshift".

Undo/Redo
You can undo or redo several actions about Shape and 

view point only.

The number of operations is different depending on the 

capacity of the memory and the kind of the operation.

*only applicable for Shapes and viewpoint.

Edit text
Put the Text box on the Canvas, and enters the text-entry 

mode.Moreover, you can arrange Text box and Shape 

on the Canvas.You can end by clicking this button in the 

Edit text mode.

Shapeshift ON/OFF

Shapeshift mode

Operate Viewpoint
You can rotate the whole Canvas using the Canvas 

Viewpoint button rather than rotating the individual object.

Each operation will be applied when dragging is finished.

Adjust viewpoint of the Shape.

Front View

Rotate view around X-axis

Rotate view around Y-axis

Rotate the Canvas align to the front view 

of the selected object

7 view point operation button functions as a rotation 

button of the object while pushing the Shift key.

Rotate Move Zoom
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Paste

Paste slides from the clipboard.

New Slide

Create a new slide. New slide will be placed after the 

selected slide.

Duplicate Slides

Duplicate the selected slide and insert just after the original

Merge Slides

Merge selected slide with the slide cut/copied in the 

clipboard.

Delete Slides

Deletes the selected slide.

To Upper Paragraph

Select [To Upper Paragraph] from context menu or press 

Arrow key [Left].

To Lower Paragraph

Select [To Lower Paragraph] from context menu or press 

Arrow key [Right].

Reset Background

Return to default the background color of the Slide Set.

Objects

Cut

Cut a Shape out from the 

Canvas to the Clipboard.

Copy

Copy a Shape from the 

Canvas to Clipboard.

Paste

Paste Shapes from the 

clipboard.

Edit Text

Input or edit the text to selected Shape.

Grouping

Group /Ungroup selected Shapes.

Order

Move the selected object Z-axis to back and forth.

The distance is different in "Grid Interval" of [View] menu 

- [Grid and Guide]. 

Angle

Reset the selected Shape angle.

Shape ID area
Shows Shape ID on this area.

Please refer to [01.Features prezvision] for details 

concerning "ID". 

Setting Color area
Text, Shape, Connector, 

and Canvas color can be 

set by Swatch, Color and 

RGB. 

Slide Properties

Object Properties (Shading)

Canvas Color

Line Color

Gradation Color

Body Color

Text Color

Color Preview
By clicking on the icon for each color setting is enabled.

Property area
If the Management Slide area is active, displays the slide 

properties and if the object is selected, will display the 

object properties.

3.Context Menu

Managing Slide area

Cut

Cut slides out to the clipboard.

Copy

Copy slides out to clipboard.
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03.Configuration

1.Setting Screen color and Resolution.

prezvision needs True Color(32bit) or higher and a Display 

Environment of XGA(1024x768) or higer.

Please refer to the following for the change in the color 

and the resolution.

1.please select  [Ajust  Screen  Resolut ion]f rom 

Windows[Control  Panel].

2.Set  the resolution "1024x768pixels" or more.

3.Select  [Advanced settings], and select [Monitor] tab.

4.Set the color "True Color(32bit)".

5.Please click [OK] button when the "system restart" 

dialog is displayed. 

* It takes time to system restart by the spec, but 
just a minute.

2.Option Settings
When you select [Option] from [Tool] menu, [Option] 

d ia log box i s  d isp layed. P lease change to the 

appropriate setting for your computer.

Edit Setting

Rendering Method

Select "GDI+" when your PC is Windows XP class or 

"Direct3D(High Quality)" when your PC is Windows Vista 

class.

Screen Aspect Retio

4:3 or 16:9

Rendering Quality

When you set [Rendering Method] DropDown box to 

"Direct3D (High Quality)", you can select either "Quality 

Priority" or "Speed Priority" in the [Rendering Quality].

When your PC is standard, select "Speed Priority". When 

your PC is High Performance PC like a designer or expert 

PC class, select "Quality Priority".

Shadow Quality

When you PC is high performance, select "3D Shadow 

(Standard)" or "3D Shadow (High Quality)". Otherwise, 

select "None".

Font Quality

Select "Low Quality", "Standard Quality" or "High Quality" 

depending on your PC performance.
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Slide Show

Rendering Method

Select "GDI+" when your PC is Windows XP class or 

"Direct3D(High Quality)" when your PC is Windows Vista 

class.

Screen Resolution

Select "1024 x 768" or other based on your projector.

Show Display

It shows Display setting.

Rendering Quality

When you set Rendering Method Direct3D, you can 

select either "Quality Priority" or "Speed Priority". When 

your PC is standard, select "Speed Priority". When your 

PC is high performance PC like a designer expert PC 

class, select "Quality Priority".

Shadow Quality

When you PC is high performance, select "3D shadow 

(Standard)" or "3D shadow (High Quality)". Otherwise, 

select "None".

Font Quality

Select "Low Quality", "Standard Quality" or "High Quality" 

depending on your PC performance.

Capture Device
Select the capture device(USB camera etc.).

Please connect the capture device before the 

application starts.

The Shadow might not be displayed by the PC 

Environment. This problem is a graphic chips related issue 

and is not related to prezvision settings.

3.Slide-Set Setting

When select the [Slide-Set Setting] from [File] menu, the 

Dialog box is displayed.

Aspect Resio

Setting size of Base Board from the aspect ratio.

Horizontal Angle of View

Set to 17.76° in default.The perspective is emphasized by 

broadening of the field angle.

Seize of Base Voard

You can set the size of Base Board from entered value.

16:9 4:3

8.93° 17.76°(Default)
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04.Text Input and Edit

1.Input and Edit Text 

Creating Text Box
Double click on the Canvas, click "Edit Text" button, or 

right click on a Shape to create a text-box.

This text box (It is called "Shape" at the following) can be 

handled as well as Shape explains in the next chapter. 

Input the Text
Double click on the Shape or click "Edit Text" button while a 

Shape is selected, You can enter a text in the Shape.

If you click outside the text box, click "Edit Text" button, or 

press "Esc" then you can leave the "Edit Text" mode.

Edit the Text
Double click the Shape that wants to correct text, select 

the Shape and [Edit Text] button, or right click on a Shape 

to create a text-box.

2.Formatting
You can change the text format.

please select Shape that wants to change the setting and 

select [Format] tab from Property area.

Setting Font

Font and Font-size

Regulated Format

The selected font will be the default font.

Indent,Outdent, and Tab

Indent

Press [Tab] at line head, or Click "Indent" button.

Outdent

Hold [Shift] and press [Tab] at line head, or Click 

"Outdent" button.

Tab

Press [Tab] at other line head.

Release

Press [Delete] or [BackSpace]

Text-alignment

Adjust the horizontal position.

Adjust the vertical position.

Detail Formatting

You can be setting detail format from [Flags] of [Format].

Flags

Word Wrap

Wrap a text automatically.

Smooth Font

Enhance the font quality.

Always Fullface

Even if a Shape rotates, the text will be displayed foward 

the front of the Canvas.

Decorate character Larger and Smaller

Indent

Outdent
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Align

Adjust vertically-aligned , horizontally-aligned, and 

line space.

Angle

Adjust a text-angle from [Angle] of 

[Format] tab.

Offset

Adjust a text offset, keeping the text alignment from 

[Offset] of [Format] tab.

Scale

Adjust a text width and height, keeping the font size from 

[Scale] of [Format] tab.

3.Find/Replace
You can find/replace and substitute the text in the 

Shape on the Canvas.

Select [Find] or [Replace] from [Edit] menu.

4.Dividing the Shape
You can divide multiple lines of text into individual text 

Shapes.

To do that, select a Text box and select [Divide by Lines] 

from the [Edit] menu.

The text will be divided into four separate text boxes.

Before

After
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05.Shape

Position
You can change the Shape position by dragging the 

Shape.You can be setting a detaile from a [Position] tab 

in the Property area.

Alignment

You can adjust the Shapes alignment in the specified axis.

Adjust the Shapes alignment 

based on Y-axis.

Ajust the Shapes alignment based 

on X-axis.

Adjust the Shapes alignment 

based on Z-axis.

Distribution

You can adjust the Shapes distribution.

Adjust the Shapes distribution 

based on X, Y, and Z-axis.

Order

Adjust the Shapes Z position.

You can be setting Move value that by one click from 

"Grid Interval" of [View] menu - [Grid and Guide].

Grouping

Group/ungroup selected Shapes.

Resizing and Modifying Shape
When a Shape is selected, grip points are displayed 

outside of the Shape. You can change the Shape size 

by dragging this grip points. The modification direction 

is different according to the Shape angle.

1.Put a Shape on the Canvas
The object you put on the Canvas 

is called "Shape" in prezvision.

To create a Shape, first select 

a category from the Category 

Selection in the Setting Shape 

area.

Then select a style from the Style 

Selection area and drag it to the 

Canvas.

Select a category and style ,and drag 

a Shape.

2.Text Input
You can enter a text to the Shape on the Canvas.

Double click on the Shape or click "Edit Text" button while a 

Shape is selected, You can enter a text in the Shape.

If you click outside the Shape, click "Edit Text" button, or 

press "Esc" then you can leave the "Edit Text" mode.

3.Shapeshift
Using the [Shapeshift ON/OFF] button, you can 

change a Shape style.

Click the [Shapeshift ON/OFF] button, or hold 

down the [Shift] key  while selecting Shape 

Style using the left mouse button.

To end Shapeshift mode, click the [Shapeshift ON/OFF] 

button again.

The state of [Shapeshift ON/OFF] button is not related to 

Shapeshift that uses the [Shift] key.

4.Position and Modification Line

You can change the line width of the Shape.

Select a Shape, and 

change the line width 

f r o m  [ L i n e ]  t a b  o f 

Property area.

Category

Style
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Moreover, there is the 

Shape with Modification 

Handle accord ing to 

Shape style.Modification 

Handle is displayed with 

the pink color grip point. 

Y o u  c a n  d o  s p e c i a l 

modification other than 

width, height, and depth 

by drag the Modification 

Handle.

Shape modification can be set from the [Size] tab in the 

Property area.

Width 	 Adjust the Shapes width.

Height 	 Adjust the Shapes height.

Depth 	 Adjust the Shapes Depth.

H1, V1	 Adjust the Shapes modification.

H2, V2	 For the Shape with two modification handle, 

	 adjust the Shapes modification.

Angle
You can change Shape angle 

on the Canvas.

You can change the angle 

by dragging Glip point (Blue, 

Green, Red) of the outside.

You can set the angle from the [Angle] tab in the 

Property area.

Rotation

Rotating the Shape based on each axis. 

Reset

Change the Shape view point based on Base Board.

Manual Rotation

Shape rotation in the Slide show is enabled.

Modification Handle

Grip Point Motion
Setting automatically rotating on the Slide.

Please set from the [Motion] tab of the Property area.

The autorotation is released by the rotation speed of the 

Shape growing by the distance of the slider of each axis 

(direction of the rotation), and clicking the reset button.

5.Shading
Setting Shade by the Shape unit.

(Direct3D mode only)

Setting from [Shading] tab in the Property area.

Ambient

Setting the brightness degree in which the directional 

lighting not hit.

Diffuse

Setting the reflectivity degree of the directional lighting.

The influence of the direction of the directional lighting 

and the direction of the object grows by this value large.

Specular

Setting degree of the specular reflection of the object 

surface.

It comes to be lustrous to the object by this value large.

Gloss

Setting degree of the specular reflection light.

The specular effect narrows, and it is displayed to Sharp 

by this value large.

The max radiance value (Luster is excluded) is decided 

by ambient light + diffuse reflection.

6.Linked from the Shape
You can be setting the link from Shape, Files, and URL.

Please select the Shape that wants to set the link, and 

setting from [link] tab in the Property area.

Y-axis Rotation

Z-axis Rotation

X-axis Rotation

Z-axis Rotation
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None

No setting the link.

File

Enter the file pass, or to Shape 

drop- in  the f i le  f rom the 

Windows Explorer.

URL
Enter the URL.

Slide
Enter the Slide ID that want to link, or drop-in the slide.

7.Sharing Property.

Sharing the property of same ID Shapes.As a result, the 

property of the Shape scattered in different slide can be 

changed in bulk by the change of the property of one 

Shape. 

Setting from [Share] tab in the Property area.

Master

Setting to the master(parent) 

Shape.

Property Integration

Inherit master props.
(Only non-master Shapes)

The property of selected Shape 

is matched to master Shape.

Link Icon

Integrate non-masters (Only master Shapes)

The property of all same ID Shapes is matched to the 

master.

Share Flags (Only non-master Shapes)

Setting sharing properties.

8.Paste Properties
You can paste the properties of copied Shape.

Right click on the selected Shapes, and select "Copy" 

from the context menu.

Select "Paste Properties" from [Edit] menu, after selecting 

the Shape.

9.Select Shapes

Selecting the Shape by clicking the Shape.

Hold down the [Shift] key while click the mouse button, 

you can select two or more Shapes.

Select with Drag
In prezvision, there is 2 selecting method of the Shapes.

When you select 2 Shapes, 

both Shapes are selected with 

the drag on the Canvas. 

But Only the globe wil l  be 

selected by adding the [Ctrl] 

key. 

Usual Drag

The Shapes that touches Rubber Band even a little is 

selected.

[Ctrl] key + Drag

The Shapes that has been installed in Rubber Band is 

selected.

Selecting The Shape from now on without 
releasing the selection.
Add the [Shift] key to the operation. 

Rubber Band

Master Icon
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In prezvision, you can connect the Shapes using a 

connector.The connector that connects the Shapes 

mutually synchronizes with the movement of the Shape 

at the transition.

When making a flow chart, this connection becomes 

effective further. 

Of course, you can put the connector on the Canvas, 

and it is possible to use it as an independent line.

1.Layout a Connector
Select a style from "Connector" 

category of the Setting Shape area.

Please begin(Starting Point) the 

drag on the Canvas.And, decide 

the End Point by the drag end. 

2.Join Shape to Shape

Join adsorption points of two Shapes on the Canvas by 

drag-and-drop.

Coupling pin appears on the connected objects.

Change the Adsorption point
You can change Adsorption point of the arranged Shape 

by dragging the starting point and end point.Connectors 

that do not unite with the Shapes either can be united 

here. 

Drag even the End Point
Starting Point

Adsorption point

Coupling pin

Change Anchor point
When the kind of the connector arranged on the 

Canvas is "Elbow" and "Curved", the anchor point is 

displayed.You can change the Anchor point position by 

drag.Moreover, both anchor points move to drag the 

line between the point and the point at the same time.

* The Anchor point of the connector doesn't move even 
if connected Shapes is moved. 

  Only connected starting point and End point 
synchronize and it moves.

3.Change The Connector Style

You can change detailed settings of connectors in the 

"Line" Tab

4.Connector Shapeshift

The connector can be Shapeshift as well as the Shapes. 

The Anchor point where "Elbow" and "curved" are moved 

is reset.

Anchor point

Drags and Moves
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07.Color and Texture

Fill Type
You can change the type of fill from [Edit Property Area].

Select the [Fill] Tab.

1)No Fill
2)Fill
3)Gradation(Horizontal)
4)Gradation(Vertical)
5)Gradation(Upper Right)
6)Gradation(Upper Left)
7)Texture Mapping
8)Capture Device

Gradation
The gradation effect can be reversed by placing a 

check in "Reversed" CheckBox when the [Fill] is set to 

the [Gradation].

Texture Mapping
You can set a texture when [Fill] is set to [Texture 

Mapping]. 

Select a texture from the dialog box by clicking [Open] 

button.

The file format that can be handled is as follows.

JPG、BMP、GIF、PNG、WMF、EMF
Moreover, the movie of the following formats can be handling. 

MOV、AVI、WMV
* MOV is Supported formats by "QuickTimePlayer" only.
* AVI and WMV are Supported formats by "Windows 

Media Player" only.

Link File
If you check here, selecte File as link file *1

1.Set a Color

You can change each object and color from the Setting 

Color area.

Change the target by the Selector button. You can 

change the color of Shape, Canvas, and etc.

1)Text	 2)Fill	 3)Gradient
4)Line	 5)Background

From Swatch
Setting a color by clicking 

the color palette.You can 

set opacity by moving 

the slider, when "Fill" or 

"Gradient" have been 

selected.Opacity grows 

by the movement of the 

slider to the right. 

From Color
Select a base color by clicking the right palette, and set 

a color shade by clicking the left palette.

Color Shade

Base Color

From RGB
Set a color by enter each value.

R : Red(0-255)

G : Green(0-255)

B : Blue(0-255)

A : Opacity(0-255)

H : Hue(0-360)

S : Saturation(0-255)

L : Luminance(0-255)

1 )     2 )     3 )     4 )     5 )

Selector button

Color Preview

Opacity Slider

1 )     2 )     3 )     4 )     5 )     6 )     7 )     8 ) 

Color Palette
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1)Fit to Shape

Modificating and displaying the texture aspect ratio to 

the Shape.

2)Sustain Aspect of Image*2

It is maximizing displayed in the Shape with texture 

aspect ratio maintained. 

3)Original Image Scale*2

Displaying with original size of the texture.

Smooth Filtering

Smoothing rough image when the expanding image.

Aliasing Free ("Direct3D" mode)

Cleaning up a visual striped pattern.

Tiling Display

The texture is spread and displayed.

Play on Click (Video)

Set a Play/Stop by clicking the Shape at the slide show.

Looped Play (Video)

The video is repeatedly played.

Insert Capture Device
Setting Capture Device from [Option] in the [Tool] menu  

dialog, after USB connection.

2.Texture Mapping Format

When [Texture Mapping] or [Capture device] are set to 

the [Fill], the mapping format can be set. 

1 )      2 )      3 )

*1	 When saving it, the texture is buried as "Packing 
data" in the file usually. 

	 However, it takes care of as not the packing data 
when the check is put in here but link data.

	 The link data is treated as an external link file. 

It becomes impossible to move or to delete the 
file, and to refer to the link data. 
Moreover, the file that exceeds 4MB is automatically 
treated as external link data in prezvision.
The purpose of this is to avoid the expansion of 
the file size when big movie is inserted.

*2	 The movie surrounding might be enlarged and be 
displayed according to the environment used. In 
that case, please use [Fit to Shape].
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08.Slide Set

1. Managing Slide

You can manage the slides you 

created on the Canvas using 

the [Managing Slide area].

Updating Slide Thumbnails
To update the slide thumbnails in [Managing Slide area]

Please click the slides you want to update.

Create a new slide

When creating new slides, The inserted slide will be 

added after the slide that is currently selected.

[New Slide] Button

Click on the [New Slide Button].

You can create a new slide using any of the following 

instruction:

- click on the [New Slide Button].

- you can also, right-click on the Slide Thumbnail, and 

select [Insert New Slide] from the context menu or 

select [New Slide] from [Insert] menu.

Duplicating Slide
You can make a duplicate copy of a slide quickly by right-

clicking the slide thumbnail of the slide you want to replicate, 

then select  [Duplicate Slides]  from  the  context  menu.

Rearranging the Slides
In the [Managing Slide area] (left side of the interface) 

You can Drag-and-drop the Thumbnail Slides, to rearrange.

Cut, copy and paste, and delete 

Cut

Cut the selected slide, and then temporarily stored in the 

clipboard.

Copy

Copy the selected slide, and then temporarily stored in 

the clipboard.

Paste

Paste slides from the clipboard.

Delete Slide

You can delete a slide using any of the following 

instruction:

- you can right-click on the Slide Thumbnail you want to 

delete, then select [Delete Slide] from the context menu. 

- you can also click on [Delete] from the [Edit] Menu, or 

press the [Delete] key from the keyboard

* Please note that prezvision Undo/Redo function does 
not work on the operation regarding slides.

Merge Slides
You can merge a selected slide with another slide. In this 

case, the background of the selected slide will apply.

Merge with other Slide Sets

Right-click on the slide you want to merge with, in the context 

menu select [Merge Slides]  -> then [from Slide Sets]

Merge with slides from the Clipboard

Copy or Cut a slide you want to merge with another 

slide. Right-click on the slide you want to merge with the 

slide stored in the Clipboard. Then select [Merge Slides] 

-> then [from Clipboard]

Paragraph
You can change paragraph by 

right-clicking on a Slide Thumbnail 

and select [To Upper Paragraph] 

or [To Lower Paragraph] from the 

context menu. You can also press 

left [←] or right [→] arrow key 

respectively.

Slide List
To view the slides in Slide List View, select [Slide List] from 

the [View] Menu.

Move

Select a Slide Thumbnail you want to go to. Then click on 
the [Move] button. You will then automatically exit the 
Slide List View and be move to the Normal View of the 
selected Slide Thumbnail. You may also double click on 

a Slide Thumbnail to move to a certain slide.

Return

To exit the Slide List View, click on the [Return] button, or 
click on the Close [×] button of the Slide List Window.
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2.Slide Properties

The [property tab] of the slide appears in the [property 

area] when you click on a slide thumbnail in the 

[Managing Slide Area].

Slide Properties

SlideShow
Duration
Set the time duration to view the selected slide during a 
slide presentation.

Move Next Slide Automatically
Put a check in this CheckBox to automatically advance 
to the next slide.

Hide during show or publishing
Exclude selected slide during a slide show and slide publishing.

Transition
Duration
Set the transition time to move from the current selected 
slide to the next slide. 

Pattern
Select the transition pattern.

Curve

Select a fine movement. The default "constant" does not 

appear when the pattern changes

#Linear-Default(black) 
#easeIn(red) 
#easeOut(blue) 
#easeInOut(yellow) 
#easeOutIn(green) 

* Transition Lenght setting can be viewed during 
SlideShow. It also affect the video output.

Master

ID

You can view and edit the slide ID in this ID Text Field.

When you create a new slide, a new ID is automatically 

generated.

Master

Select the type of the master.

Viewpoint

Camera Position

You can set the camera position by specifying a value 

for X, Y and Z-axis.

Camera Angle

You can set the camera angle by specifying a value for 

X, Y and Z-axis.

Lighting

Enable Editing

Please check the [Editable] CheckBox to enable editing.

If it is disabled, it will follow the Light Source viewpoint.

Light Position

set a value for the Light Position.

Light Angle

set a value for the Light Angle.

Shadow

Opacity

Adjust the depth of shadow.

* When the display method of the [Shadow Quarity" is set 
to "None" in [Option], the effect doesn't become visible.
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4.Creating a New Slide Set 

To create a new Sl ide Sets,  select [New] in the 

application File Menu.

To start the application, [Start Menu]-[All Programs]-

[SoftAdvance]-[prezvision] from [prezvision] or you 

can double-click a desktop shortcut to exexute the 

application.

5.Open and Save a Slide Set

Open
To open a previously created Slide Sets, select [open] 

from the [File] menu, then select the Slide Sets you want 

to open. You can also Drag and Drop an "rez" file into 

the Canvas and it will automatically be opened in the 

application.

Save

to Save a new Slide Set

Select the [Save] from the [File] Menu. A dialog box will 

appear to let you enter a file name.

to Save changes made to an exisiting Slide Set

You can simply select the [Save] from the [File] Menu.

Save As
You save the changes into a new File Name using the 

same extension file (***. rez) format. A dialog box will 

appear for you to select a location, enter a file name, 

and click on the [Save] button to apply the changes.

When overwriting an existing file, in the [Save As] Dialog 

box, select the slide you want to overwrite then click [save] 

or you can just simply double-click on the Slide Set you 

want to overwrite and the [Save As] will be executed.

3.Insert a Sound File

You can insert a sound file to the selected slide. And you 

can play and listen to the sound file in the slide.

* Inserted sound file is only linked into the slide. It is 
not embedded.

Sound Files that can be inserted  are as follows: 

WAV, MP3, AU, AIFF, M4A

Sound on this Slide

Open

Select a sound file from dialog box.

Clear

Clear the inserted sound file.

Test

Check the sound file, you will be able to listen to the 

sound file.

* This is different from the Windows Playback software 

Keep beyond this slide    

Continue to play the sound file even after this slide’s time 

frame.

* If you have a different sound file inserted in another 
slide, the sound file will stop from that slide

Loop

to enable the sound file to continously play from 

beginning everytime it ends.

* The sound stops when the reproduction ends even if 
there is a check in "Keep beyond this slide" when the 
check is not here.

Sound from othe slides

Halt on this slide

The reproduction of the sound inserted in other slides is 

compulsorily stopped.

* When the check is here, the sound from the slide that 
there is a check in [Keep beyond this slid] of [Sound 
on this Slide] stops. 

* When the slide moves between slides in which the 
same sound file is inserted, if the check is not put in 
here, Cue is not done, and the sound is reproduced 
continuously. 

* The inserted sound is not reflected in the movie output. 
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About File Packing
All Video and Images in prezvision are embedded into the 

rez file. If the file size is 4MB or above, Image and video-

files will not be packed in the prezvision file.

Interoperability(Data FileSize), Performance is determined 

by considering the input and output time. In addition, 4MB 

or less image and video files.

In the Shape Property, under the [Fill] tab:

[Link to File] in [texture mapping] can be checked, and 

this will exclude it from File Packing

6.Merge Slide Set

You can add another 

Slide Set from the current 

Slide Set you are working 

on by select [Slide Set] 

under the [Insert] menu. 

S e l e c t  t h e  S l i d e  S e t 

Insert Position from the 

Operation drop down list, 

then click the [OK] button

You can select a SlideSet to insert from the Dialog Box

Operation
Select the insert method from the drop down list

Merge

The existing Slide Set will be merge with the Slide Set 

being inserted.

Replace All Slides

The slide will be replaced. Slide Set created will be lost. 

Inserted before the current location

Insert a Slide Set Before the selected slide.in the [Slide 

Managing area]

Insert after current position

Insert a Slide Set After the selected slide.in the [Slide 

Managing area]

Select Folder

You can use your own Slide Sets by selecting a different 

folder 

Default Folder

Displays the default prezvision Slide Set.

* Please note that prezvision 2 Undo and Redo function 
does not work on the operation regarding slides.

Inserting a Slide from Managing Slide area
You can insert a SlideSet in the Managing Slide area as well.

Right-click on a Slide Thumbnail. Then select [Merge 

Slides] -> [From Slide Set]. 

From Slide Set

Right-click on the slide you want to merge with, in the 

context menu select [Merge Slides]  -> then [from Slide 

Sets]

From Clipboard

Copy or Cut a slide you want to merge with another 

slide. Right-click on the slide you want to merge with the 

slide stored in the Clipboard. Then select [Merge Slides] 

-> then [From Clipboard]

7.Creating a Link Slide

You can  generate  individual  slides linked from each 

Shape on the Canvas. Select a Shape with text title, then 

select [Create LinkSlide] from the [Edit] menu.  A slide is 

automatically created that is linked  from the Shape. You 

can create more links and more slides will automatically 

generated. In each slide that was created, a text object is 

copied at the  upper left corner of  the Canvas. When you 

click the original text object in the slide show, You will jump 

to the generated slide where it is linked to.

8.Canvas

Using Slide Master
You can use Master Slide to create the base of the Slide 

set design, layout and background.

Select  "Master"  from the  [View] menu,  You  can edit  

the  title master and the master slide.

Title Master

Represents the layout of the First Slide in the Presentation.

You can access Title master in the Slide Properties.

Link Icon
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10.Grid and Guide 

Click on [Grid and Guide] 

under [View] menu to view 

Grid and Guide in the Canvas

Snap

Snap to Grid

Put a tick mark at "Snap To Grid"  CheckBox  to activate 

the snap feature.

Grid

Grid Interval

Put a check on the [Display Grid] CheckBox to display 

or hide the Grid lines. You can also specify the pixel 

parameter.

Guide

Displaying Guide

Check the [Display Guide Lines] CheckBox to show 

the Guide Lines.

Slide Master
Under the Slide Property, under the [Master] section of 

the [Master] Tab, please select "Slide Master".

Change the Master

Select a master type from 

[Master] under the Slide 

Property.

Go back to Edit Mode
To return to edit mode, Select [Edit] from [View] Menu.

9.Viewpoint Operation

Save and Load a ViewPoint
You can save and load a viewpoint using select  

"Viewpoint" from [Edit] menu.

Save Temporary

Save the Canvas viewpoint.

Load Temporary

Load the temporary viewpoint.

[Canvas Viewpoint] button
You  can rotate  the  whole Canvas  by dragging 

the  [Canvas ViewPoint] buttons rather than rotating 

individual objects.

Using the buttons below: Front View, Rotate view around 

X-axis, Rotate view around Y-axis, Show the front view of 

a selected object, you can rotate an object in different 

perspective. When you click on the [X-axis], [Y-axis] rotate 

button, each click will rotate 45 degrees to the direction of 

the arrow increments.

Front View

Rotate view around X-axis

Rotate view around Y-axis Y 

Rotate the Canvas align to the front view 

of the selected object

There are 7 buttons perspective, while holding down the 

[Shift] key you can and manipulating the button you can 

rotate the object in different perspective. 

Rotate Move Zoom
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You can create multiple slides with Transitions. In prezvision 

you can see it on screen in Horizontal and Vertical  (X,Y) 

axis and Depth (z) axis in addition.

1.Run and End a Slide Show

Run a SlideShow

Start from the First Slide

Press [F5] , or select [Run] from [Slideshow] menu.

Start from the Selected Slide

Hold the [Shift] key down and press  [F5] , click 

[Slideshow] buttton, or select [Slideshow] from 

[View] menu.

Auto Run
Select  "Auto Run" from [SlideShow]  menu.

Auto run the slideshow from the top slide, returning to th

e first slide from the last slide.

In the Auto Run mode, the running time depends on the 

slide properties.

End Slide Show
To quit during a slide show, right-

click on any part of the screen 

then select [Exit] from the context 

Menu. Also, you can press [F5] 

key or [Esc] key in the keyboard 

to end the current slide show.

2.Operating in a Slide Show

Operating with the Keyboard

Go to previous slide

Arrow Key [Up], PageUp, BackSpace

Go to the next slide

Arrow Key [Down], PageDown, Enter, Space

Left-click on the screen.

Go to the previous paragraph

Arrow Key [Left]

Go to the next paragraph

Arrow Key [Right]

Return to edit mode

[F5] key, [Esc] key

Operating from the context menu
The context menu will appear by right-clicking on any 

part of the screen during Slide Show.

Previous slide

Go back to the previous slide.

Next Slide

Move to the next slide.

Slide List

To view lists of the slides.

Exit

To exit the slide show and return to edit mode.

Changing Viewpoint
During a slide show, it is possible to change the viewpoint 

of the Canvas.

XY coordinate movement

Drag on the Mouse Wheel Button.

Z coordinate movement

[Shift] key + drag the Mouse Wheel Button.

Rotation

[Ctrl] key + drag the Mouse Wheel Button.

>> Also please see Keyboard Shortcuts. (p.032)

Rotating Shape
In edit mode, the properties of Shape Angle, select 

Manual Rotation

Action Shape you check the machine when the slide show

Usudoraggu can be rotated. During the slide show

The Shape of the rotation angle will be reflected in Edit 

mode.

link from your Shape
By clicking the l ink Shapes that are attached to 

phosphorus

Subject to network files, slides, URL to display Can be.

If you see a link to the file.

* The slide show The exit and return to editing.
* PowerPoint slides on the link to the outside is not 

available.
>> PowerPoint slide show on prezvision (P.026)
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This [Link] is given to priority even if the movie is set by 

texture mapping, and "Play on Click" is made effective. 

3.Pause and Play the Movie

The movie that [Play on Click] is checked in the Shape 

property repeats "Play" and "Stop" at the click. 

Please check [Texture Mapping] and [Play on Click] in 

Shape Properties [Fill] tab.

The setting of the link is given to priority when the link is 

set to this Shape.

4.Slide List

To view the slides in Slide List View, select [Slide List] from 

the [View] Menu.

Move

Select a Slide Thumbnail you want to go to. Then click on 
the [Move] button. You will then automatically exit the 
Slide List View and be move to the Normal View of the 
selected Slide Thumbnail. You may also double click on 

a Slide Thumbnail to move to a certain slide.

Return

To exit the Slide List View, click on the [Return] button, or 

click on the Close [x] button of the Slide List Window.

End Slide Show

Close [×] button to return to edit mode.

5.Multi-Display
prezvision corresponds to the multi-display, and enables 

presentation that uses two displays. 

Configuration
P l e a s e  c h a n g e  t h e  d i s p l a y 

displaying ahead from [Option] of 

[Tool] menu. Please connect an 

external display before running 

p r e z v i s i o n .  T h e  r e a c t i v a t i o n 

of prezvis ion is  needed when 

connecting it while running. 

When an external display is recognized, "#1" and "#2" are 

displayed in "Show Display". 

Please select "#2" to enable the multi display function.

Slide show at Multi-Display mode
As for the slide show at the Multi-Display mode and a 

single display, behavior is different. 

Primary (PC Screen)

The slide list appears when you run a slide show slides.

Secondary (External Display)

The slide show displays.

Slide List at Multi-Display mode
As for [Move] button at the Multi-Display mode and a 

single display, behavior is different. 

When "Movement" button is clicked, the selected slide is 

displayed in secondary without ending the slide list.

Orange Frame
Selected Slide

Red Frame
Showing Slide
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Create Data
Excel runs, and the input screen is displayed as shown in 

the figure below. At this time, prezGraph automatically 

changes to the [Preview] tab.

[Preview] tab

Shape Type

Select the Shape type used the 

graph.

Draw Border

Displaying the line.

[Preview]  button

You can confirm the graph before 

graph inserts.

[1]-[4] button

You can change the viewpoint to preview.

* After clicking the preview button, becomes effective.

Preview area

Displaying the preview.

Graph Size

The graph size arranged in prezvision is set. 

In default, it is automatically set by [Slide-set Setting] of 

prezvision. 

"Link to the Microsoft Office" is feature in prezvision. "Link 

to PowerPoint" and "Create 3D Graph from Excel" are 

enables High-quality presentation.

1.Create 3D Graph

That can make 3D graph from 

Excel  data.3D graph on the 

Canvas can be handled as well 

as other Shapes.

When select "Graph" of "Insert" 

menu, the graph making wizard 

"prezGraph" runs.

You can also start prezGraph as a Stand-alone application. 

Please select [prezGraph] in the prezvision installation folder.

*In this section, we will use [Bar Chart 1] as an 
example for our discussion

TopMost

prezGraph is displayed on the foremost side while 

operating other applications. 

[Exit] button

It returns to the operation screen of prezvision when start 

from prezvision. 

prezGraph
When prezGraph at the time of startup, [Select Graph]  

tab is selected first.

[Select Graph] button

Chart Type

Select chart type.

[Create Data] button

The Excel sheet for the data input is displayed based on 

the selected graph.

Initialize File Template

When graph is inserted, the Excel file closes with the 

content maintained. The template file can be initialized 

by putting the check in here. 

Select an arbitrary graph and clicking [Create Data] 

button.

prezGraph

Preview area
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Input data within the range in the figure below.

The data area can increase the Column and Row. 

When you create data, please confirm by [Preview] 

button or Viewpoint [1] - [4] button of prezGraph, and 

click "Insert Graph" button. 

At this time, you can change the graph size.

3D graph is inserted in the Canvas of prezvision as 

shown in the figure below.

3D graph on the Canvas can be handled as well as 

other Shapes. Let's release Grouping, and change 

the Shape color etc. 

2.Import PowerPoint File

Convert PowerPoint files to a prezvision file.

On the [File] menu, select [From PowerPoint] from [Import 

Data]

Please select a PowerPoint 

f i le  then f rom the Impor t 

PowerPoint Dialog Box.

It will then start to import the 

PowerPoint file. As shown on 

the right, it wil l display the 

progress of the file import.

The imported file will then inherit the 3D and streamless 

transition feature of prezvision that would make your 

presentation more effective. 

The gradation of the 
orange was set, and 
the Shape style also 
changed.
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3.prezvision on PowerPoint 

The prezvision slide show can be inserted in PowerPoint. 

A strong accent can be added by partially inserting the 

prezvision slide show in an existing file.

For PowerPoint 2007
[prezvision] is automatically 

added in PowerPoint2007 during 

installation. You can access 

[prezvision] under the [Add-In] 

Menu of PowerPoint2007.

New

Running prezvision , and create a rez file.

Insert

Insert an existing rez file to the slide of Powerpoint .

For PowerPoint2007, the first slide of prezvision is displayed. 

For PowerPoint2003,the thumbnail is displayed.

Export

Changing and saving Powerpoint file to the rez file.

rez File Properties

Right-click on the thumbnail of  the inserted rez files.

Select [Properties] from [.rez  ControI  Object ].

You can control prezvision file property] on PowerPoint 

application.

For PowerPoint 2003
Select [Object] from PowerPoint 

[Insert] menu.

The d ia log of  the [ Inser t ion 

Object] of the figure below is 

displayed. Please select "Rez".

Here, please do not put the check in "Display as Icon". 

prezvision thumbnail will appear in the PowerPoint Slide.

Right click on the slide thumbnail, and in the context menu, 

select [Properties] from [Rez ControI Object].

Click the [Open] button, then you would be able to 

browse and select a file.In PowerPoint2003 and 2007 you 

will be able to control the prezvision file properties.

Once you have selected a file, the [Open] button will 

disappear after that.

Security Warning

When you include PowerPoint files in your prezvision 

slides, you may get warnings lin the figure below.

Please select [Yes]

Limitation during Slide Show

When prezvision file is being run in PowerPoint, below are 

the Limitations.

+ Import Display from Capture Device
+ When it is linked to a file, prezvision will then 

end the slide show. The link will then enable the 
program to launch. 

+ URL link function
+ Slide List

* In PowerPoint, when prezvision SlideShow are viewed, 
prezvision Option Settings are applied.

>> Option Setting (P.007)
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11.Insert External Files

1.Insert Picture

You can insert an Image and movie files on the Canvas.

Supported file formats as below.

Image

JPG, BMP, GIF, PNG, WMF, EMF
* GIF files may include GIF animation.

Movie

MOV, AVI, WMV
* MOV is Supported formats by "QuickTimePlayer" only.
* AVI and WMV are Supported formats by "Windows 

Media Player" only.

Select "From File" from "Picture" in the "Insert" menu.The 

selected file is arranged on the Canvas.

Insertion by the drag Inn from the Windows Explorer is also 

possible. When the image is inserted in the Canvas, it is 

arranged as new Shape.Moreover, it is displayed as a 

texture in the Shape when inserting it in plased the Shape. 

2.Insert Image from Capture Device

To insert an image on the Canvas from Captured Device 

connected in the computer: from the [Insert] Menu, 

select [Capture Device]

Inserted Image from Capture Device will be treated 

likeShape. The Capture Device can be set from the 

Property Area.

* Please connect the Capture Device in the Computer 
before using starting-up prezvision.

* Before using the device, please check the compatibility 
of the Capture Device in [DirectShow]

The Image from Capture 
Device i s  p laced in  the 
Canvas

Drag-in to Shape

Drag-in on the Canvas

3.Inserting 3D Shape model

To insert a 3D Shape Model in the Canvas:

go to [Insert] menu then select [3D Shape Model].

The inserted 3D Shape Model can be handled like Shape. 

The following File Format are supported in prezvision:

+ Metasequoia(MQO)file format
+ Alias FBXfile format

For more information regarding creat ing these 

types of files, please refer to the individual software 

documentations, websites and other resources.

Metasequoia(MQO) file format
prezvision supports MQO file ver 2.4 or lower.
The Properties below are supported in prezvision.
+ Texture Mapping and UV Coordinates Setting
+ smoothing and smoothing angle setting
+ Mirroring , all formats are supported in Control Surfaces

The following properties are not supported in prezvision:
+ Vertex Color
+ Metaballs
+ Solid of Revolution Setting
+ Shade Setting
   (It uniformly becomes Phong shading.）
+ Transparent Mapping Setting
+ Irregularities Mapping Setting

Alias FBX file format
prezvision is compatible with Maya, 3D Studio Max, XSI 

,Lightwave output file with FBX file extension.Polygnal Geometry 

and UV coordinates are compatible with  prezvision. 

The following properties are not supported in prezvision.

+ Vertex Color
+ Shade Setting
   (It uniformly becomes Phong shading.）
+ Settings of mapping other than color mapping
+ Local Material
+ Animation Related Information
+ User normal
+ Surface and Layer Information
+ FBX binary embedded format 
+ Format other than: Bmp,Jpeg,GIF,PNG,TIFF
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prezvision has a printing capability to convert slides into 

PDF Files on the File menu, click [Print as PDF]. 

1.Publish Setting

Publish Target

Set on the number of slides per page.

Publish Range

All Slides

Regardless and paragraphs, print(convert to PDF) the 

slides on all levels

Level 1-2 Slides

Print(convert to PDF) all slides, except Level3

Level 1 Slides only

Print(convert to PDF) only Level 1 slides

Header

Enter the text. to be displayed in the header area

Footer

Enter the text. to be displayed in the footer area

Base Quality

Select the PDF file quality.

Add a frame to each slide

Give the outside border of the slide.

Page Number

Add a page number 

Date & Time

Put the date and time

[Publish] button.

Convert slides into PDF base on the defined setting.

[Cancel] button

To cancel the settings and return to Slide Edit Mode

Example: Publish Target 

Handout
(2 slides / page)

Handout
(4 slides / page)
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13.Exporting to Other Format

Select [Export Data] from [File] menu, export the Slide Set to 

other format data.

1.As SnapShots

When the snap shot is selected, the output setting 

dialog like the figure below is displayed. The output 

is generated as image file (PNG Format)

Instant Setting
You can select a resolution from the settings provided in 
the drop down box.

Resolution setting
Specify resolution width and height 

Image Setting
Compression quality
Sets the image quality.

Output Range
Paragraphs can be specified in the output range.

Estimated Cost
Displays the predicted export time.
* Please use this for your reference.

2.As Image Sequence

When you select [as Image Sequence] from [Export 
Data]. The number of images depend on the slide 
properties. You convert the Slide Set into sequential 
image, and can output it.

In this case the "Duration of Transition" and "Duration of Slide 
Show" in the properties will be reflected.
numbered automatically as [File Name 000000],[File Name 

000001] and so on.

Instant Setting

You can select the number of frames from the second 

set was prepared with the resolution.

Resolution setting

Set the resolution of any size.

Sequence Image Setting

Frame per Second

Affects the smoothness of the animation. Higher values 

will be smoother transition.This will also affect the number 

of files generated on output, since it is base on the 

number of frame.

Compression Quality

Sets the image quality.  This would make the output file 

large if the quality of image is set on a finer quality.

Output Range

Paragraphs can be specified in the output range.

Estimated Cost
Displays the estimated time it takes to output.

* Please use this for your reference.  
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3.As Movie 

1.As QuickTime
When selecting [QuickTime Movie] from [As Movie], the 

output setting dialog of the figure below is displayed. 

* QuickTime Player 7 or later is required

Insert Setting

You can select the number of frames from the second 

set was prepared with the resolution.

Resolution setting

Set the resolution of any size.

Video Settings

Frame per Second

Affects the smoothness of the animation. Higher values 

will be smoother transition.This will also affect the number 

of files generated on output, since it is base on the 

number of frame.

Compression quality

Sets the image quality.  This would make the output file 

large if the quality of image is set on a finer quality.

Output Range

Paragraphs can be specified in the output range.

Estimated Cost
Displays the estimated time it takes to output.

* Please use this for your reference.  

2.As Video For Windows
When selecting [Video For Windows] from [As Movie], the 

output setting dialog of the figure below is displayed. 

Insert Setting

You can select the number of frames from the second 

set was prepared with the resolution.

Resolution setting

Set the resolution of any size.

Video Settings

Frame per Second

Affects the smoothness of the animation. Higher values 

will be smoother transition.This will also affect the number 

of files generated on output, since it is base on the 

number of frame.

Output Range

Paragraphs can be specified in the output range.

Estimated Cost
Displays the estimated time it takes to output.

* Please use this for your reference.  

* If the out file exceeds 2GB, it is automatically split 
each into 2GB.
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In the Output Setting dialog box, click the [Ok] button 

and the dialog box below will then appear. 

Set each item as needed then click the [Ok] button 

compression program that can be selected (codec), will 

vary depending on your environment setting.

3.As Windows Media Video
When selecting [Windows Media Video] from [As Movie], 

the output setting dialog of the figure below is displayed. 

* Windows Media Player 9 or higher is required.

Insert Setting

You can select the number of frames from the second 

set was prepared with the resolution.

Resolution setting

Set the resolution of any size.

* Please set the [width] value in a multiple of 4, and 
Multiple of 2 for the [height]. 

Video Settings

Frame per Second

Affects the smoothness of the animation. Higher values 

will be smoother transition.This will also affect the number 

of files generated on output, since it is base on the 

number of frame.

Video Bit

Set the quality of the output.The higher the value the 

better the quality, output time will take longer and 

Output file. Will be larger in capacity.

Output Range

Paragraphs can be specified in the output range.

Estimated Cost
Displays the estimated time it takes to output.

* Please use this for your reference.  

After sett ing each item 

in the Setting Dialog Box, 

please click the [OK] Button

As shown on the right, the 

prev iew screen wi l l  be 

displayed as it generates 

the output.

The movie can be created 

on the web to be viewed 

by more audience.

* The sound is not reflected in the movie output. 

4.Export as 3D Shape 

Slides can be converted into 3D Shapes file format.

File formats that can be handled are the following two

+ Metasequoia(MQO) file format
+ Alias FBX file format

For more information regarding creat ing these 

types of files, please refer to the individual software 

documentations, websites and other resources.Please 

note that the following properties cannot be converted.

+ Shape Edge
+ 3D model Shape from the import function
+ View and light source information
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In prezvision, you can make use of convinient Keyboard 

Shortcuts as follows.

1.Text Operation

Display the Find dialog box

[Ctrl] key + [F] key

Display the Replace dialog boxy

[Ctrl] key + [H] key

2.Objects Operation

Select All Objects

[Ctrl] key + [A] key

Clear All Selection

[Ctrl] key + [D] key

Copy

[Ctrl] key + [C] key

Cut

[Ctrl] key + [X] key

Paste

[Ctrl] key + [V] key

Moving Objects

Move the position X-axis

Arrow keys [Left], [Right]

Move the position Y-axis

Arrow keys [Up], [Down]

Move the position Z-axis

Mouse Wheel

[Shift] key + Arrow keys [Up], [Down]

Object rotation

X-axis Rotation

[Ctrl] key + Arrow keys [Up], [Down]

Y-axis Rotation

[Ctrl] key + Arrow keys [Left], [Right]

Z-axis Rotation

[Ctrl] key + [Shift] key + Arrow keys [Up], [Down]

Duplicating Objects

[Ctrl] key + drag

Changing the Shape of the object (Shapeshifting)

[Shift] key + select "Shape style"

3.Viewpoint Operation

Moving Viewpoint

X-axis Movement

[Alt] key + Arrow keys [Left], [Right]

Y-axis Movement

[Alt] key + Arrow keys [Up], [Down]

Z-axis Movement

[Alt] key + [Shift] key + Arrow keys [Up], [Down]

Rotating perspective

X-axis Rotation

[Alt] key + [Ctrl] key + Arrow keys [Up], [Down]

Y-axis Rotation

[Alt] key + [Ctrl] key + Arrow keys [Left], [Right]

Z-axis Rotation

[Alt] key+[Ctrl] key+[Shift] key+Arrow keys [Up], [Down]

Temporary Saving Viewpoint

[Ctrl] key + [1] - [3]

Temporary Loading Viewpoint

[1] - [3]

4. Luminous source Operation

Current Perspective

[F1] key

Oblique view from the top left of the current

[Shift] key + [F1] key

Temporary Loading Luminous source

[Ctrl] key + [Shift] key + [1] - [3]

Temporary Loading Luminous source
[Shift] key + [1] - [3]

5. Read and store a set of slides

Reading Slide Set

[Ctrl] key + [O] key

Save a Slides Set

[Ctrl] key + [S] key
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6.Run Slideshow

From the first slide

[F5] key

From the selected slide

[Shift] key + [F5] key

7.Undo and Redo

Undo

[Ctrl] key + [Z] keys

Redo

[Ctrl] key + [Y] key

8.Managing Slide area

Multiple slide selections

since the second slide [Shift] key + click

Create a new slide

[Ctrl] key + [M] key

Moving Paragraphs

Arrow Keys [Left], [Right]

9.Slideshows

Slide Movement

Arrow Keys [Up], [Down]

Slide Movement in relation with Paragraph

Arrow Keys [Left], [Right]

Blackout function

[B] key

White-Out function

[W] key

End of Slide Show (Return to Edit mode)

[F5] key, [Esc] key

10.Others

User Guide (PDF) view

[F1] key

※ Adobe Reader is required.

Create a new Slide Set

[Ctrl] key + [N] key

Print as PDF

[Ctrl] key + [P] key
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